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Preface

This Users’ Guide supports the use of the GRNLEASE Lotus 1-2-3 release 5.0 template on
either conventional Windows 3.1 or Windows 95 microcomputer operating systems.  This
program was designed to support analysis of any of the grain crops that are included in the
government program. A menu in the program allows the user to select the type of grain that is to
be used in the analysis.  The five types of grains that are included in the FAIR Act are: wheat,
corn, grain sorghum, barley, and oats.  Further explanation of how to change between alternative
grain types is contained later in the Users’ Guide.  This program was developed in conjunction
with a similar program for rice, RICELEAS; there is also a COTLEASE template for cotton,
which is also subject to the FAIR Act of 1996.  A paper entitled “Landowner/Tenant Issues in the
Texas Rice Industry,” Agricultural and Food Policy Center Policy Issues Paper 96-3, has been
written to address some tenant landowner issues in the Texas Rice industry.  Although that paper
does not speak of grain or cotton, it provides useful information about the FAIR Act of 1996, and
its effects on agriculture.    Similar sets of software have also been developed to deal with the
landlord tenant issue in the cotton and rice industries.  Copies of  the software, Users’ Guide, and
the noted paper may be obtained either through your local county agent, Larry Falconer at Corpus
Christi (512/265-9203), or Joe Outlaw in College Station (409/845-3062).

The development of this software was funded by the Texas Agricultural Experiment Station
(project H-3914), Texas Agricultural Extension Service, Texas Rice Research Foundation, and
Rice Belt Warehouse, Inc.

Installation Instructions

The Grain Land Tenure Evaluation software is a Lotus template.  This means that the program
must be run using Lotus 1-2-3.  This program is designed to run with either Windows 95 or
Windows 3.1 or higher operating systems, and Lotus 1-2-3 release 5.  A computer with 8mb of
RAM and a 486 processor is also recommended, but not required.  Since the program is a Lotus
template, Lotus 1-2-3 r 5 must be running before you can load the program. 
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Once inside Lotus, you must open a file.  At the top of the Lotus program you will notice a menu
bar with several menu options on it.  In the top left corner is the “File” menu item.  To open a
file, pull down the “File” menu and click the “Open” option.  Upon selecting the open option, the
Open File dialog box will appear, as shown on the previous page.

Under the “Drives” section, select the letter of the 3.5 inch drive on your computer.  Then select
the file entitled GRNLEASE.WK4 from the list of files appearing along the left side.  Click the
OK button, and Lotus 1-2-3 r 5 will bring up the Grain Land Tenure Evaluation program.  You
will note there are several sheets comprising this spreadsheet file; the customized menu features
incorporated into the GRNLEASE.WK4 file facilitate moving from one area of the spreadsheet
to another as necessary.  

After the program has loaded up the first thing you should see is the opening screen
below:

If you do not see the opening screen above, something is not working properly.  Try and reload
the file, going back through the steps outlined above.  If problems persist, call Joe Outlaw in
College Station (409/845-3062).

Overview
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What the Grain Land Tenure Evaluation Program is designed to do:  This Lotus template
takes enterprise budget information for grain farm operations and evaluates the expected returns
to producers and landowners under various lease scenarios.  The landowners’ results from
renting their land for grain farming are compared with their receiving 100% of  the returns from
market transition payments plus the user-specified net returns from an alternative enterprise, thus
calculating the net advantage to landowners for renting their land for grain production under the
budgeted scenario over the life of the FAIR Act.

The Grain Land Tenure Evaluation Program allows the user to evaluate any desired share
arrangement, but for ease of use, it contains ten default lease share options that the user may
select from, and then modify if desired.    

The user can print any one of six programmed reports by using the Print option on the menu. 
These reports include: 1) the base data on program yields, expected prices, and market transition
payments; 2) land tenure arrangements (landowners’ percentage of different cost items being
shared); 3) enterprise budget information; 4) sensitivity table analyses for both the tenant and
landowner for the current operating period; 5) sensitivity table analyses for the tenant over the
life of the FAIR Act; and 6) sensitivity table analyses for the landowner over the life of the FAIR
Act.  The user may also print all six reports at once.  An example of each of these reports appears
toward the end of this Users’ Guide.

Limitations:  This program was designed with a very specific purpose in mind, that being to
identify expected returns to landowners for two basic alternatives: (a) continuing to engage their
land in grain production, considering alternative tenure arrangements, expected production costs,
and ranges of expected yields, and prices; and (b) ceasing use of their land in grain production,
and engaging it instead in an alternative use, whereby they realize 100% of the market transition
payments and the user-specified net returns for the alternative enterprise.  Therefore, it is limited
in its analytical capabilities.  The Grain Land Tenure Evaluation is not designed to:

� Be prescriptive, i.e, indicate what one should do -- it simply evaluates alternatives based
on user-supplied data.

� Evaluate leasing options for alternative enterprises -- this program only evaluates grain
leases.

� Account fully for risk management -- it does not incorporate users’ subjective
probabilities for expected yields and prices, the option of crop insurance, or the effects of
marketing contracts, among other possible considerations.

� Allow for direct, side-by-side comparisons of tenure arrangements for the grain enterprise
as well as for other cropping alternatives.
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A more comprehensive software program designed to address the above stated issues will be
available during the Summer of 1997.

Please Note:

The user may enter data in the cells that appear in blue text; blue text is “unprotected,” allowing
for users to change it, replacing it with their own values.  All other cells are programmed as
formulas, and should not be changed by the user.  Doing so will corrupt the integrity of the
program and result in the output being inaccurate.  To protect against such accidental changes of
formula cells, users are encouraged to maintain one or more original versions of the program in a
secure location.  Note: in this Users’ Guide, the unprotected cells appear in a light shade of
grey.     

Moving around the program : To move from one section to the next, simply access the pull-
down menus located at the top of the screen.  Inside the “move to” pull-down menu is a list of all
the places that you can go to inside the program.  To move around within any of the data entry or
analysis sections, use the mouse in conjunction with the horizontal and vertical scroll bars at the
right hand side and bottom of the display.  The arrow keys may also be used to move within a
page.

Required Data  
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The data required to generate results are entered into the (a) Base Data, (b) Land Tenure,  and (c)
Budget sections.  These data include:

Base Data Section:

Analysis Description: This label is the information that will be printed in the heading of all the
pre-programmed reports.  It provides the user with the capability of labeling different analyses.

Farm Payment Yield: The established yield for a particular Farm Service Agency (FSA) farm
unit; this yield is used by the FSA for determination of market transition payments.  Be sure to
adjust this figure to the appropriate level for the farm unit being analyzed.

Grain Yield : Expected grain yield (bu/ac, or cwt/ac) for the farm unit being evaluated.

Grain Price: Expected harvest time price ($/bu, or $/cwt) for grain crop during the budgeted
period.

+/- Increments for What If : The price and yield increments in $/cwt, or $/bu and cwt/ac, or
bu/ac that are used to define alternative price and yield levels for the tenant and landowner
sensitivity analysis tables.  This program calculates returns under various yield and price
scenarios.  The yield and price specified, along with the +/- increments, define the different yield
and price levels used to calculate the returns.  The sensitivity calculations are presented both for
+/- one and +/- two increments about the specified yield and price levels, i.e., a total of twenty-
five different yield and price combinations are evaluated.

Alternative Return : These values represent net cash flows from the next best alternative
enterprise that will accrue to the landowner if the land is not rented to a tenant for grain
production.  These values are used to calculate the net advantage to the landowner for allowing
the land to remain in grain production, and be farmed by a tenant producer.

Annual discount rate: This value is used in net present value calculations to adjust the tenant’s
and landowners’ cash flows to evaluate the net returns per acre over the 1997-2002 period.  A
desired rate of return for the land in the analysis could be used (e.g., 5-7%) or, alternatively, users
may choose to use their opportunity cost of capital for borrowed funds (e.g., 7-12%).  Returns for
the 1996 crop year are not included in the net present value calculations since this crop year is in
the past, and as such, does not affect future decisions.  Note: once the 1997 crop year has
occurred, 1997 consequences should be excluded from the NPV calculations; call Joe Outlaw
(409/845-3062) or Ed Rister (409/845-3801) for information on how to make these revisions.

Land Tenure Section:
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Analyze : This column of values is the current tenure arrangement being evaluated.  These data
may be selected from a set of default options from the menu bar using the Analyze menu.  The
user has the option of customizing these scenarios by entering alternative values, or he/she may
enter an entirely new alternative directly into the worksheet.  The user may also alter the
percentages that are shown in the ten customized tenure arrangements, even though the text is
black.  These cells are not formulas and changing them will not affect the operation of the
program.  Any tenure specific allocation changes that the user wishes to keep for subsequent
analytical sessions need to be saved prior to exiting the program.  Then, the next time the
program is opened, the customized tenure arrangements will be available, including any saved
changes; be advised, however, that the original tenure arrangements that were altered will no
longer be available for that lease, users are advised to keep an original version of this template in
a secure location.

Enterprise Budget Section:

The following three data items are required to determine the wet weight of grain being handled
and dried so that accurate costs can be calculated.  The grain yield data is to be entered in dry
weight terms.

Harvest Moisture Percentage: The amount of grain moisture when harvested, e.g., 16-18%.

Dry Moisture Percentage: The base moisture percentage for the grain to be marketed, or a
target moisture level for dry grain, e.g., 14% for milo, 15.5% for corn.

Handling Shrink: Percentage reduction occurring as yields are transformed to dry yields, due
primarily to handling losses, e.g., 0-1%.

Variable Production Input Levels and Costs:  All of the data entry regarding costs and inputs
are done in the Enterprise Budget Section. These data are mainly usage rates of variable inputs
with corresponding costs.  Fixed costs may be entered on a per acre basis near the bottom of the
enterprise budget (while these fixed costs will appear in the printed enterprise budget report, they
are not considered in other aspects of the analysis (e.g., the sensitivity tables) as the fixed costs
are considered irrelevant to the “grow grain” vs “pursue an alternative enterprise” decision -- that
is, the fixed costs will occur regardless of the enterprises grown on the land).  The areas that
require data entry are colored with blue text, to symbolize a data entry cell.  Do not enter data in
cells that do not have blue text -- this will cause a formula to be erased, and the program to
function improperly (refer to the Please Note item at the top of p.  4).  

Menu Options
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File menu:

The File Menu can be accessed by clicking on the File section of the menu.  The File Menu
contains options for opening, closing, and saving files.  

Open : the Open command allows the user to open a new file inside the Lotus program.    If you
open a new file, you will be leaving the Grain Land Tenure Evaluation program and opening
another Lotus spreadsheet file. 

Close : the Close command allows the user to close a file inside the Lotus program.  If you
choose the Close option, then you will be closing the Grain Land Tenure Evaluation program.  It
is recommended that the user save the current file by using the Save As option and entering an
analysis-specific file name before closing.

Save As? : the Save As?  command allows the user to save the current file.  You may save the
file under the current name, or change the name of the file and preserve the data under a analysis-
specific file name.  It is recommended to periodically save the file as you progress through the
worksheet.  This helps to prevent data loss due to an accidental data entry, or unforeseen program
shutdown by the computer system. 

Exit : the Exit  command allows the user to exit the Grain Land Tenure Evaluation program and
the Lotus 1-2-3 program.  It is recommended the the user save the data as discussed above before
exiting.  

Print menu:

The Print  menu is a customized menu that allows the user to print a variety of reports.  The
option exists to print either one report at a time, all reports at once, or a user-specified
combination of the six reports.  The user can access the print menu by clicking the Print option
on the customized main menu bar.  After clicking on the Print menu, the user is presented with
the Print dialog box shown on the following page.

Inside the dialog box, the user can select any combination of six pre-defined reports, and a cover
page.  To select the items to be printed, click on the box next to the title of the report(s) to be
printed and click OK.  Be sure your printer is on and loaded with paper before executing this
print command.
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The available reports include: 

Base Information on Yields, Prices, and Transition Payments: this report contains the base
information on FSA program yield, expected yields, expected price, annual $/ac cash flows for an
alternative enterprise over the remaining life of the FAIR Act, and the discount rate used in the
analysis for net present value calculations.

Land Tenure Arrangements: the specific land tenure arrangement (percentage of crop returns
and different cost items being shared) that is being analyzed for the particular scenario, along
with the rest of the available alternatives.

Enterprise Budget Information: the enterprise budget information that represents the cost
structure for the specific grain production scenario that is being analyzed.

Sensitivity table for landowner and tenant, net of payments: the sensitivity table analyses for
both the tenant and landowner for only the current operating period, net of (ignoring) any
transition payments.  

Sensitivity table for tenant over the life of the FAIR Act: the sensitivity table analyses for the
tenant over the life of the FAIR Act (1996 -2002), including tenant’s designated share of
transition payments.  Positive values indicate returns exceed all variable costs while negative
values indicate the opposite.

Sensitivity table for the landowner over the life of the FAIR Act: the left side represents the
sensitivity table analyses for the landowner continuing to rent his/her land to a tenant producer
for grain farming over the life of the FAIR Act (1996-2002), including landowners’ designated
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share of transition payments.  Positive values indicate landowners’ share of returns exceed
landowners’ share of variable costs while negative values indicate the opposite.  The middle
column of values represents the respective annual net returns realized by landowners who
discontinue their grain lease and engage their land in its next best use, while also receiving 100%
of the market transition payments.  The right side of this output represents the net advantage to
the landowner for continuing use of his/her land in grain production compared to using it in the
specified next best use and receiving 100% of the market transition payments.  A positive value
indicates returns are highest if grain production is continued with a tenant while a negative value
signals the landowners’ pursuit of the next best alternative accompanied by their receipt of 100%
of the market transition payments is more profitable.

The user may also print all six reports at once by selecting the All Information  option from the
dialog box.

Analyze menu:

The Analyze menu allows the user to select any of ten pre-defined land tenure arrangements.  A
user can select the option they would like to analyze by clicking on the desired selection with the
mouse, or by using the arrow and enter keys.  The program then over-writes the contents of the
Analyze column in the Budget page, and immediately updates all calculations to reflect the
desired tenure arrangement.  If the user changes any component of the tenure or budget data, 
the REFRESH menu item needs to be executed as described below before the results are
valid.    

Move To menu:

The Move To menu allows the user to move around throughout the worksheet.  By selecting one
of the seven options, the user can move to the sections specified by that option.

Misc. menu:

The Misc. menu allows you to either (a) switch to the Lotus 1-2-3 menu or (b) refresh the data
and calculations inside the worksheet.

Reset to 1-2-3 menu: this command allows the user to toggle to the standard Lotus 1-2-3 menu
system.  If you do toggle to the standard menu, after completing the intended Lotus tasks, you
may then return to the Grain Land Tenure Evaluation program’s customized menus by selecting
the Menu option that has been added on the far right side of the standard Lotus 1-2-3 menu bar.  
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*IMPORTANT*

Refresh: allows a user who has changed data within the land tenure section or the
enterprise budget section to recalculate the sensitivity tables using the new data values.  For
example, if you select the 1/4a share arrangement from the Analyze menu, then the
program automatically computes the sensitivity tables using that data.  However, if you go
to the land tenure section and adjust the percentages after having selected a tenure
alternative, the program will not automatically update the tables.  Similarly, if you make an
adjustment in the Enterprise Budget section or elsewhere, such changes are not
automatically reflected in the results sections.  The user must move to the Misc menu and
choose the Refresh option.  The program then takes the data that has just been changed
and re-calculates the sensitivity tables.

Crops menu:

The Crops menu allows the user to select the type of grain to be analyzed.  The types of grains
that are available for analysis are: wheat, grain sorghum, corn, barley, and oats.  To choose one of
the five types of grains, simply click on the Crops menu.  A dialog box will appear asking you to
select the grain to be analyzed.  The program then applies the data from the type of grain that was
chosen to the worksheet, and allows you to continue with the analysis.  In order for the data in the
current worksheet to be kept, it must be saved prior to selecting another crop from the Crops
menu.  This can be done by selecting the Save As option under the File menu, as described
above.  When a different crop is selected for analysis, the current data in the worksheet is
immediately replaced with data for the new grain type.   

Help Menu: The Help menu allows you to access the Lotus 1-2-3 help screens.

Reports

Each of the following six pages is an example presentation of the six respective reports
that may be generated using this program.  The values used in this example are for a case farm
situation in District 11, identified in December of 1996.  
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%DVH�$VVXPSWLRQV &RUQ

$QDO\VLV�'HVFULSWLRQ Texas Coastal Bend (District 11)

)DUP�3D\PHQW�<LHOG bu/ac 70.00

��RI�DFUHV�SDLG�RQ % 85.00%

*UDLQ��<LHOG bu/ac 70.00

����\LHOG�LQFUHPHQWV bu 5.00

*UDLQ��3ULFH $/bu $3.08

����SULFH�LQFUHPHQW $/bu $0.15

$QQXDO�3D\PHQW�5DWHV $OWHUQDWLYH�UHWXUQ

���� $/bu $0.2508 $/ac ($12.00)

���� $/bu $0.4807 $/ac ($12.00)

���� $/bu $0.3762 $/ac ($12.00)

���� $/bu $0.3657 $/ac ($12.00)

���� $/but $0.3344 $/ac ($12.00)

���� $/bu $0.2717 $/ac ($12.00)

���� $/bu $0.2612 $/ac ($12.00)

$QQXDO�GLVFRXQW�UDWH % 10.00%

11
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Land Tenure Arrangements /DQGRZQHU
V�6KDUH�RI�&URS�DQG�([SHQVHV�IRU�$OWHUQDWLYH�7HQXUH�$UUDQJHPHQWV
Corn 1/3a 1/3b 1/4a 1/4b 30% a 30% b C25 C35 C50 C0

Analyze #1 #2 #3 #4 #5 #6 #7 #8 #9 #10

5(9(18(6
Grain  Sales 33.33% 33.33% 33.33% 25.00% 25.00% 30.00% 30.00% 0.00% 0.00% 0.00% 0.00%
OTHER 33.33% 33.33% 33.33% 25.00% 25.00% 30.00% 30.00% 0.00% 0.00% 0.00% 0.00%
CASH RENT $0.00 $0.00 $0.00 $0.00 $0.00 0.00% 0.00% $25.00 $35.00 $50.00 $0.00
OTHER 33.33% 33.33% 33.33% 25.00% 25.00% 30.00% 30.00% 0.00% 0.00% 0.00% 0.00%
OTHER 33.33% 33.33% 33.33% 25.00% 25.00% 30.00% 30.00% 0.00% 0.00% 0.00% 0.00%
GROSS RECEIPTS
=========================

9$5,$%/(�&2676

SEED 33.33% 33.33% 0.00% 25.00% 0.00% 30.00% 0.00% 0.00% 0.00% 0.00% 0.00%
HERBICIDE 33.33% 33.33% 0.00% 25.00% 0.00% 30.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INSECTICIDES 33.33% 33.33% 0.00% 25.00% 0.00% 30.00% 0.00% 0.00% 0.00% 0.00% 0.00%
FERTILIZER 33.33% 33.33% 0.00% 25.00% 0.00% 30.00% 0.00% 0.00% 0.00% 0.00% 0.00%
LABOR $0.00 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
FUEL 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
REPAIRS 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
APPLICATIONS -- AERIAL 0.00% 0.00% 0.00% 0.00% $0.00 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
APPLICATIONS -- GROUND 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
IRRIGATION $0.00 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
HARVESTING (wet weight) 33.33% 33.33% 0.00% 25.00% 0.00% 30.00% 0.00% 0.00% 0.00% 0.00% 0.00%
HAULING (Wet weight) 33.33% 33.33% 0.00% 25.00% 0.00% 30.00% 0.00% 0.00% 0.00% 0.00% 0.00%
DRYING 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER $0.00 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INTEREST (weighted int rate) 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

=========================

),;('�&2676

DEPRECIATION 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INSURANCE 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
REPAIRS $0.00 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
TAXES (property) 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INTEREST ON CAPITAL INVESTMENT 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER FC 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER FC 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

Share of Transition Payment 33.33% 33.33% 33.33% 25.00% 25.00% 30.00% 30.00% 0.00% 0.00% 0.00% 0.00%

Tenure Arrangement Label 1/3a 1/3a 1/3b 1/4a 1/4b 30% a 30% b C25 C35 C50 C0
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Harvest Moisture 16.00%
Dry Moisture 14.00%

Handling shrink 0.50%

GRAIN PRODUCTION ENTERPRISE BUDGET Texas Coastal Bend (Dis trict 11) Corn

  WET/DRY WEIGHT INDEX 1.0179
************************************************************************************************************************

Owner/Operator Tenant Landowner LAND RENTAL

UNITS/AC $/UNIT $/AC $/AC $/AC TERMS

REVENUES 1/3a
==========================================================================================
Grain  Sales 70.0 $3.08 $215.60 $143.73 $71.87 33.33%
OTHER 0.0 0.00 0.00 0.00 $0.00 33.33%
CASH RENT($/ac) 0.00 0.00 0.00 $0.00
OTHER 0.00 0.00 0.00 0.00 0.00 33.33%
OTHER 0.00 0.00 0.00 0.00 0.00 33.33%
GROSS RECEIPTS $215.60 $143.73 $71.87 n/a
==========================================================================================

VARIABLE COSTS

SEED 1 20.00 20.00 13.33 6.67 33.33%
HERBICIDE 1 3.43 3.43 2.29 1.14 33.33%
INSECTICIDES 1 11.87 11.87 7.91 3.96 33.33%
FERTILIZER 1 26.40 26.40 17.60 8.80 33.33%
LABOR 1 12.59 12.59 12.59 0.00 0.00%
FUEL 1 10.57 10.57 10.57 0.00 0.00%
REPAIRS 1 3.39 3.39 3.39 0.00 0.00%
APPLICATIONS -- AERIAL 1 0.00 0.00 0.00 0.00 0.00%
APPLICATIONS -- GROUND 1 0.00 0.00 0.00 0.00 0.00%
IRRIGATION 1 0.00 0.00 0.00 0.00 0.00%
HARVESTING (wet weight) 39.90 0.70 27.93 18.62 9.31 33.33%
HAULING (wet weight) 39.90 0.00 0.00 0.00 0.00 33.33%
DRYING (wet weight) 39.90 0.00 0.00 0.00 0.00 0.00%
OTHER 0 0.00 0.00 0.00 0.00 0.00%
OTHER 1 0.00 0.00 0.00 0.00 0.00%
INTEREST (weighted int rate) 116.18 0.0461 5.36 5.36 0.00 0.00%

Variable Costs sub-total $121.54 $91.66 $29.88 n/a

Returns Above Variable Costs 94.06 52.07 41.99
==========================================================================================

FIXED COSTS

DEPRECIATION 1 42.16 $42.16 42.16 0.00 0.00%
INSURANCE 1 0.00 $0.00 0.00 0.00 0.00%
REPAIRS 1 0.00 $0.00 0.00 0.00 0.00%
TAXES (property) 1 0.00 $0.00 0.00 0.00 0.00%
INTEREST ON CAPITAL INVESTMENT 1 0.00 $0.00 0.00 0.00 0.00%
OTHER FC 1 0.00 $0.00 0.00 0.00 0.00%
OTHER FC 1 0.00 $0.00 0.00 0.00 0.00%

Fixed Costs  sub-total $42.16 42.16 0.00

==========================================================================================
TOTAL COSTS/ACRE $163.70 $133.82 $29.88
==========================================================================================
TOTAL NET/ACRE --Return  to Land and Profit $51.90 $9.91 $41.99
==========================================================================================
Break-even Price, All Production Costs le $/bu $2.339 $1.912 $0.427
Break-even Price, All Production Costs $/bu $2.339 $1.912 $0.427
Break-even Price, Variable Costs $/bu $1.736 $1.309 $0.427
Break-even Price, Fixed Costs $/bu $0.602 $0.602 $0.000
==========================================================================================
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Texas Coastal Bend (District 11) &RUQ

Net of Transition Payments
:KDW�,I�7DEOH�IRU�7HQDQW���5HWXUQV�$ERYH�9DULDEOH�&RVWV�

3ULFH� $/bu 1/3a
�7(15$9& $2.78 $2.93 $3.08 $3.23 $3.38

<LHOG 60.00 22.38 28.38 34.38 40.38 46.38

EX�DF 65.00 30.23 36.73 43.23 49.73 56.23
70.00 38.07 45.07 52.07 59.07 66.07
75.00 45.92 53.42 60.92 68.42 75.92
80.00 53.76 61.76 69.76 77.76 85.76

:KDW�,I�7DEOH�IRU�/DQGRZQHU���5HWXUQV�$ERYH�9DULDEOH�&RVWV�

3ULFH� $/bu 1/3a
�/$1'5$9& $2.78 $2.93 $3.08 $3.23 $3.38

<LHOG 60.00 27.05 30.05 33.05 36.05 39.05

EX�DF 65.00 31.02 34.27 37.52 40.77 44.02
70.00 34.99 38.49 41.99 45.49 48.99
75.00 38.96 42.71 46.46 50.21 53.96
80.00 42.93 46.93 50.93 54.93 58.93
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$QQXDO�DQG�139�RI�5HWXUQV�7DEOH�IRU�7HQDQW��5$9&�

7H[DV�&RDVWDO�%HQG��'LVWULFW���� Corn

Base w/o transition payments
Yield 1/3a
bu/ac 3ULFH� $/bu
�7(15$9& $2.78 $2.93 $3.08 $3.23 $3.38

60.00 22.38 28.38 34.38 40.38 46.38
65.00 30.23 36.73 43.23 49.73 56.23
70.00 38.07 45.07 52.07 59.07 66.07
75.00 45.92 53.42 60.92 68.42 75.92
80.00 53.76 61.76 69.76 77.76 85.76

Annual, considering transition payments

1996 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 32 38 44 50 56
65.00 40 47 53 60 66
70.00 48 55 62 69 76
75.00 56 63 71 78 86
80.00 64 72 80 88 96
1997 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 41 47 53 59 65
65.00 49 56 62 69 75
70.00 57 64 71 78 85
75.00 65 72 80 87 95
80.00 73 81 89 97 105
1998 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 37 43 49 55 61
65.00 45 52 58 65 71
70.00 53 60 67 74 81
75.00 61 68 76 83 91
80.00 69 77 85 93 101
1999 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 37 43 49 55 61
65.00 45 51 58 64 71
70.00 53 60 67 74 81
75.00 60 68 75 83 90
80.00 68 76 84 92 100
2000 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 36 42 48 54 60
65.00 43 50 56 63 69
70.00 51 58 65 72 79
75.00 59 67 74 82 89
80.00 67 75 83 91 99
2001 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 33 39 45 51 57
65.00 41 48 54 61 67
70.00 49 56 63 70 77
75.00 57 64 72 79 87
80.00 65 73 81 89 97
2002 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 33 39 45 51 57
65.00 41 47 54 60 67
70.00 48 55 62 69 76
75.00 56 64 71 79 86
80.00 64 72 80 88 96

NPV* $2.78 $2.93 $3.08 $3.23 $3.38
60.00 160 186 212 238 264
65.00 194 222 250 279 307
70.00 228 258 289 319 350
75.00 262 295 327 360 393
80.00 296 331 366 401 436

*NPV is  for 1997-2002, discounted into 1997 $s .
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$QQXDO�DQG�139�RI�5HWXUQV�7DEOH�IRU�/DQGRZQHU��5$9&�

7H[DV�&RDVWDO�%HQG��'LVWULFW����

&RUQ

Grain  is grown No Grain Advantage to growing Grain 
Base w/o transition payments Base w/o transition payments

Yield 1/3a Yield 1/3a
bu/ac 3ULFH� $/bu bu/ac 3ULFH $/bu
�/$1'5$9& $2.78 $2.93 $3.08 $3.23 $3.38 �/$1'5$9& $2.78 $2.93 $3.08 $3.23 $3.38

60.00 27.05 30.05 33.05 36.05 39.05 60.00 39.05 42.05 45.05 48.05 51.05
65.00 31.02 34.27 37.52 40.77 44.02 ($12.00) 65.00 43.02 46.27 49.52 52.77 56.02
70.00 34.99 38.49 41.99 45.49 48.99 70.00 46.99 50.49 53.99 57.49 60.99
75.00 38.96 42.71 46.46 50.21 53.96 75.00 50.96 54.71 58.46 62.21 65.96
80.00 42.93 46.93 50.93 54.93 58.93 80.00 54.93 58.93 62.93 66.93 70.93

Annual, considering transition payments Annual, considering transition payments

1996 $2.78 $2.93 $3.08 $3.23 $3.38 1996 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 32 35 38 41 44 60.00 29 32 35 38 41
65.00 36 39 42 46 49 65.00 33 36 40 43 46
70.00 40 43 47 50 54 $2.92 70.00 37 41 44 48 51
75.00 44 48 51 55 59 75.00 41 45 49 52 56
80.00 48 52 56 60 64 80.00 45 49 53 57 61
1997 $2.78 $2.93 $3.08 $3.23 $3.38 1997 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 37 40 43 46 49 60.00 20 23 26 29 32
65.00 41 44 47 50 54 65.00 24 27 30 34 37
70.00 45 48 52 55 59 $16.60 70.00 28 31 35 38 42
75.00 48 52 56 60 63 75.00 32 36 39 43 47
80.00 52 56 60 64 68 80.00 36 40 44 48 52
1998 $2.78 $2.93 $3.08 $3.23 $3.38 1998 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 35 38 41 44 47 60.00 24 27 30 33 36
65.00 38 42 45 48 51 65.00 28 31 35 38 41
70.00 42 46 49 53 56 $10.38 70.00 32 36 39 43 46
75.00 46 50 54 58 61 75.00 36 40 44 47 51
80.00 50 54 58 62 66 80.00 40 44 48 52 56
1999 $2.78 $2.93 $3.08 $3.23 $3.38 1999 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 34 37 40 43 46 60.00 25 28 31 34 37
65.00 38 42 45 48 51 65.00 29 32 35 38 42
70.00 42 46 49 53 56 $9.76 70.00 32 36 39 43 46
75.00 46 50 54 57 61 75.00 36 40 44 48 51
80.00 50 54 58 62 66 80.00 40 44 48 52 56
2000 $2.78 $2.93 $3.08 $3.23 $3.38 2000 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 34 37 40 43 46 60.00 26 29 32 35 38
65.00 38 41 44 47 51 65.00 30 33 36 40 43
70.00 42 45 49 52 56 $7.90 70.00 34 37 41 44 48
75.00 46 49 53 57 61 75.00 38 41 45 49 53
80.00 50 54 58 62 66 80.00 42 46 50 54 58
2001 $2.78 $2.93 $3.08 $3.23 $3.38 2001 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 32 35 38 41 44 60.00 28 31 34 37 40
65.00 36 40 43 46 49 65.00 32 35 39 42 45
70.00 40 44 47 51 54 $4.17 70.00 36 40 43 47 50
75.00 44 48 52 56 59 75.00 40 44 48 51 55
80.00 48 52 56 60 64 80.00 44 48 52 56 60
2002 $2.78 $2.93 $3.08 $3.23 $3.38 2002 $2.78 $2.93 $3.08 $3.23 $3.38
60.00 32 35 38 41 44 60.00 29 32 35 38 41
65.00 36 39 43 46 49 65.00 33 36 39 42 46
70.00 40 44 47 51 54 $3.54 70.00 37 40 44 47 51
75.00 44 48 52 55 59 75.00 41 44 48 52 56
80.00 48 52 56 60 64 80.00 45 49 53 57 61

NPV* $2.78 $2.93 $3.08 $3.23 $3.38 NPV* $2.78 $2.93 $3.08 $3.23 $3.38
60.00 149 162 175 188 201 60.00 108 121 134 147 160
65.00 166 180 194 209 223 65.00 125 139 154 168 182
70.00 183 199 214 229 244 $40.99 70.00 142 158 173 188 203
75.00 201 217 233 250 266 75.00 160 176 192 209 225
80.00 218 235 253 270 288 80.00 177 194 212 229 247

*NPV is  for 1997-2002, discounted into 1997 $s. *NPV is  for 1997-2002, discounted into 1997 $s

Landowner takes all payment and alternative returns for 1997-2002.
Payment Altern Total

1996 14.92 -12.00 2.92
1997 28.60 -12.00 16.60
1998 22.38 -12.00 10.38
1999 21.76 -12.00 9.76
2000 19.90 -12.00 7.90
2001 16.17 -12.00 4.17
2002 15.54 -12.00 3.54

NPV97-02 93.25 -52.26 40.99
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